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File Explorer is one of the most crucial tools in Windows 11, as it lets you browse and manage files stored on your computer. This is the tool that allows you to browse all the files on your PC, so you can open, delete, rename them, and much more. If you've been using Windows laptops for a while, using File Explorer may feel like second nature to you,
but you might be surprised at just how much you don't know. And if it's the first time using Windows in a while, then there's a lot you'll want to learn about. This guide will show you everything you need to know to get to grips with it, from the most basic functionality to more advanced settings even more frequent users may not know. This guide is
based on the latest version of File Explorer in Windows 11 version 23H2 and newer. Older versions may look different, but the core functionality is similar. Related Want to customize your context menus? Here's how How to open File Explorer You can open File Explorer on Windows 11 in a few ways: Option 1: Click the File Explorer icon on the
taskbar Option 2: Press Windows + E on your keyboard Option 3: Open the Start menu and search for File Explorer Option 4: Press Windows + R to launch the Run window and then enter explorer Option 5: Right-click the Start button and select File Explorer When you first open File Explorer, there are a few main Ul elements you'll want to take note
of. Let's take a look at the main File Explorer window. There are a few primary elements you'll want to get familiar with here: Tab bar: You'll see the titles of your open tabs and you can switch between them here (only available in Windows 11 version 22H2 or newer). Navigation buttons: Includes back, forward, up, and refresh buttons. Address bar:
Shows the current path in the main view and lets you navigate the folder structure. Search bar: Lets you search for items in the current view (including sub-folders). Ribbon: The ribbon contains file management tools like copy, cut, delete, and rename, as well as filtering and sorting options for your current view. Options shown in the ribbon
depending. Navigation pane: Shows the folder structure of your PC and highlights the current folder in the main view. Main view: Shows you the files and folders in the path you're currently in. You can double-click a file or folder to open it. Navigate to the folder or file you want to copy. Right-click the file or folder and choose Copy from the context
menu. Alternatively, click the file once and then press Ctrl + C to copy it, or click Copy in the ribbon. Navigate to the folder where you want to copy the file. Right-click an empty area of the main view and choose Paste. You can also press Ctrl + V to paste a file, or click Paste in the ribbon. Navigate to the folder or file you want to move. Right-click the
file or folder and choose Cut from the context menu. Alternatively, click the file once and then press Ctrl + X to cut it, or click Cut in the ribbon. Navigate to the folder where you want to move the file. Right-click an empty area of the main view and choose Paste. You can also press Ctrl + V to paste a file, or click Paste in the ribbon. If you have
multiple windows or tabs open, you can also click and drag a file from one location to another to move them. Navigate to the file you want to delete Right-click the file and click Delete. You can also click the file and click Delete in the ribbon, or press the Delete key on your keyboard. Using tabs in File Explorer works similarly to how most modern web
browsers work. Here's how it works: Open a new tab Option 1: Click the + (plus) button in the tab bar. Option 2: Press Ctrl + T on your keyboard. Open a folder in a new tab Option 1: Right-click a folder in the main view or navigation pane and click Open in new tab Option 2: With a desktop mouse, click the scroll wheel (middle-click) a folder to open
it in a new tab. Close a tab Option 1: Click the small X button next to the tab title (not to be confused with the large X in the top right corner of the window). Option 2: Press Ctrl + W on your keyboard to close your active tab. Option 3: With a desktop mouse, click the scroll wheel (middle-click) an open tab to close it. Re-order tabs Option 1: To move
tabs on the tab bar, click and drag them to the position you want them in. Option 2: To move tabs to a separate window, click and drag the tab outside the File Explorer window, then release it. Move files between tabs Click and hold the file or folder you want to move. Drag it over the tab you want to move it to and hold it until the main view switches
to that tab. Drag the file to the main view. File Explorer hides extensions for known file formats by default. If you'd like to see them, use these steps: Click the View option in the ribbon Hover over Show and then choose File name extensions. Certain files can be hidden from view in File Explorer. To see them, do this: Click the View option in the
ribbon. Hover over Show and then choose Hidden items. The Home page in File Explorer shows the files and folders that are most relevant to you across three sections: Quick Access, Favorites, and Recent: Pin or unpin folders from Quick access Quick access contains your pinned folders as well as frequently visited folders. A few folders are pinned by
default, like Pictures, Videos, and Downloads. To unpin a folder you don't want to see here: Right-click the folder you want to unpin. Click Unpin from Quick access. On the other hand, to pin new folders to Quick access, follow these steps: Navigate to the folder you want to add to Quick access. Right-click the folder and choose Pin to Quick access.
Hide frequent folders from Quick access To hide frequently visited folders from the Quick access section, do this: Click the ellipsis icon in the ribbon and choose Options. Uncheck the box labeled Show frequently used folders. Click OK. This way, you'll only see pinned folders. Add files to Favorites Similarly to pinned folders, you can add individual
files to your favorites to have them appear on the Home page. Navigate to the file you want to add to your favorites. Right-click it and choose Add to Favorites. You'll now see it under the Favorites section of the Home page. To remove a favorite file, right-click it and choose Remove from Favorites. Hide recent files Finally, the Recent section shows
files you've recently opened. If you don't want this section to appear, follow these steps: Click the ellipsis icon in the ribbon and choose Options. Uncheck the box labeled Show recently used files. Click OK. Hide online files The Recent section can also show documents you have stored in OneDrive. If you only want to see local files: Click the ellipsis
icon in the ribbon and choose Options. Uncheck the box labeled Show files from Office.com. Click OK. If you don't like the new context menu in Windows 11's File Explorer: Right-click any folder or file you want to act on. Click Show more options. Alternatively, you can hold Shift on your keyboard and right-click with the mouse to see the classic
context menu right away. Related The new context menu isn't for everyone File Explorer is an essential tool in Windows that allows users to browse, manage, and organize files and folders efficiently. If you are experiencing issues or need assistance using File Explorer, this guide will walk you through everything you need to know to get help with File
Explorer in Windows.What is File Explorer in Windows?File Explorer, previously known as Windows Explorer, is a built-in file management application in Windows operating systems. It enables users to navigate the file system, access files, and perform operations like copying, moving, renaming, and deleting files. Additionally, it provides access to
external devices, network drives, and cloud storage services like OneDrive.How to Open File Explorer in WindowsThere are multiple ways to open File Explorer in Windows:Using the Keyboard Shortcut: Press Windows + E to open File Explorer instantly.From the Taskbar: Click on the File Explorer icon in the taskbar.Using the Start Menu: Click on
the Start menu, type “File Explorer,” and select it.Using the Run Command: Press Windows + R, type explorer, and hit Enter.Via Command Prompt or PowerShell: Open Command Prompt (cmd) or PowerShell, type explorer, and press Enter.Common Issues with File Explorer and How to Fix ThemlIf you are facing problems with File Explorer, here are
some common issues and solutions:1. File Explorer Not Responding or FreezingPossible Causes:Corrupt system filesOutdated Windows updatesOverloaded cacheConflicting third-party applicationsSolution:Restart your computer.End the explorer.exe process in Task Manager (Ctrl + Shift + Esc > Processes > Windows Explorer > Restart).Clear File
Explorer history (Go to File Explorer Options > Clear history).Update Windows to the latest version (Settings > Update & Security > Windows Update).Boot into Safe Mode and check if the issue persists (Windows + R > type msconfig > Boot tab > Safe boot > Restart).2. File Explorer Running SlowSolution:Disable Quick Access: Open File Explorer
Options, set “Open File Explorer to” as “This PC” instead of “Quick Access.”Optimize Folders: Right-click the slow folder > Properties > Customize > Optimize for General Items.Run Disk Cleanup: Type “Disk Cleanup” in Start and remove temporary files.Disable unnecessary startup programs (Task Manager > Startup tab).Increase virtual memory
(Control Panel > System > Advanced system settings > Performance > Advanced > Virtual memory).3. Missing or Disappearing FilesSolution:Use the search bar in File Explorer to locate files.Check the Recycle Bin.Enable hidden files (View > Show > Hidden Items).Run a system file scan (sfc /scannow in Command Prompt).Restore previous versions
of files (Right-click file/folder > Properties > Previous Versions).4. File Explorer Keeps CrashingSolution:Disable unnecessary startup programs (Task Manager > Startup).Scan for malware using Windows Security (Windows + I > Update & Security > Windows Security).Perform a system restore (Control Panel > Recovery > Open System
Restore).Create a new Windows user profile (Settings > Accounts > Family & other users > Add someone else to this PC).Advanced Tips to Get Help with File Explorer in WindowsIf basic troubleshooting doesn’t solve your problem, here are additional methods to get help with File Explorer in Windows:1. Use Windows TroubleshooterGo to Settings >
Update & Security > Troubleshoot > Additional troubleshooters > Windows Explorer > Run the troubleshooter.2. Reset File Explorer SettingsOpen File Explorer Options (Control Panel > File Explorer Options).Click on the Restore Defaults button.3. Run System File Checker (SFC) and DISMOpen Command Prompt as Administrator and type:sfc
/scannowlIf SFC doesn’t resolve the issue, run:DISM /Online /Cleanup-Image /RestoreHealthThis repairs system image issues.4. Use Windows Support and Community ForumsVisit the Microsoft Support website.Post your query in the Microsoft Community Forums.Contact Microsoft Customer Support if the issue persists.5. Check for Windows
UpdatesKeeping Windows up to date ensures you have the latest bug fixes and security patches.Go to Settings > Update & Security > Windows Update > Check for updates.File Explorer AlternativesIf you are looking for an alternative to File Explorer, consider the following file managers:Total Commander - Advanced file management with dual-pane
interface.XYplorer - Portable file manager with tabbed browsing.Directory Opus - Highly customizable file explorer replacement.FreeCommander - Lightweight, efficient file manager with dual-pane navigation.ConclusionFile Explorer is a powerful tool in Windows, but it can sometimes encounter issues. If you need help with File Explorer in
Windows, try the troubleshooting steps outlined in this guide. Whether it’s fixing crashes, improving speed, or finding missing files, these solutions will ensure smooth file management on your PC. Additionally, using alternative file managers can provide enhanced features if you need more flexibility.Read Also: To fix many File Explorer issues, open to
Task Manager > Processes, right-click Windows Explorer, and choose "Restart." You can open File Explorer Options window and click "Clear" to clear the utility's cache to resolve many problems. Other solutions include launching folder windows in a separate process, scanning the PC for viruses and malware, updating Windows, and more. File
Explorer can sometimes act weird, crash, or become unresponsive. If you're experiencing issues with Explorer, I have a few ways to help you fix any issues you might be experiencing. Restart the File Explorer Process When File Explorer freezes up or malfunctions, first, force the process to end and then restart. This gives it a fresh start, which will fix
a bunch of minor problems. To do that, launch Task Manager by pressing Ctrl+Shift+Esc. From the left sidebar, select "Processes." On the right pane, find the process that says Windows Explorer, right-click it, and choose "Restart." File Explorer will close and re-open. File Explorer caches various items to make your experience smoother and faster.
Sometimes, this cache becomes corrupted, causing various nondescript problems. In this case, clearing the saved cache will probably fix the issue. You don’t lose any of your files and folders when you clear the cache. File Explorer rebuilds the cache as you use the utility. Launch Windows Search (press Windows+S), type File Explorer Options, and
choose the item with that name. In the File Explorer Options window, open the "General" tab if you aren’t already there. In the Privacy section, click the "Clear" button. You won't get a notification but know that the cache is cleared. Close the window by clicking "OK." Then, launch File Explorer as usual, and it should work as expected. You can toggle
on an option so that File Explorer launches each folder window in a separate process. This way, if a specific window has an issue, that issue won’t affect other open windows. To do that, open Windows Search, type File Explorer Options, and select the item with that name. On the File Explorer Options window, access the "View" tab. In the Advanced
Settings section, turn on the "Launch Folder Windows in a Separate Process" option. Then, select "Apply" followed by "OK." Open File Explorer and the issue should be fixed. It’s possible File Explorer is acting weird because your PC is infected with a virus or malware. In this case, run a full virus scan to remove any threats from your computer. You
can use an antivirus of your choice or the built-in Microsoft Defender Antivirus to run a scan. To use the latter, open Windows Search, type Windows Security, and launch the app. From the left sidebar, select "Virus & Threat Protection." On the right pane, choose "Scan Options." On the following page, select "Full Scan" and choose "Scan Now." You
can choose the Quick Scan option, but that scan will not be as thorough as the Full Scan option. Wait for Windows Security to fully and thoroughly scan your PC and remove any threats. This can take several minutes, or longer, depending on how much storage your PC has. Once the scan is complete, restart your Windows 11 PC. One reason File
Explorer may be having issues is a software bug—they're not super common, but it has happened. Windows system updates often resolve such problems, so update your PC to fix such issues. To do that, open Settings by pressing Windows+i, then, from the left sidebar, select "Windows Update." On the right pane, at the top, click "Check for Updates."
Wait for Windows to find the latest updates. Download and install the available updates, then reboot your PC. It’s possible the current user account has a problem, causing issues with File Explorer. In this case, switch to a different account on your PC and see if the problem persists. If you don’t already have a different account, it’s easy to create local
user accounts on Windows 11. Once you have an additional account set up, log out of your current account. Do that by opening the Start Menu, clicking your account name, and selecting "Sign Out" in the top-right corner. Before logging out of your account, make sure to close any open apps and save any unsaved work, or you risk losing your data.
Choose the account to log in to and sign in to the account. Then, launch File Explorer and see how it works. If you don’t notice any issues, your previous account likely had issues. In this case, you can try fixing problems with your account, or transfer all your files to a new account. Windows 11 offers a clean boot mode where you can disable all non-
essential services and use your PC. This allows you to find out if a specific third-party item is causing the problem. Once you find such an item, you can disable or remove it. To enter clean boot mode, open Run by pressing Windows+R. Type the following in the open box and select "OK" or press Enter: msconfig In the System Configuration window
that opens, access the "Services" tab. At the bottom of the service list, enable the "Hide All Microsoft Services" option. Then, choose "Disable All." This turns off all the non-Microsoft services for when you enter clean boot mode. Open the "Startup" tab and click "Open Task Manager." In Task Manager, right-click each app whose Status column says
"Enabled" and choose "Disable." This turns off all the startup apps. Then, quit Task Manager. Back on the System Configuration window, click "OK." Restart your computer, and you’ll enter clean boot mode. If File Explorer works fine in this mode, one or more of the services you disabled were the culprit. In this case, enable one service at a time to
find the culprit, then remove the app that’s responsible for that service from your PC. And that’s how you fix issues with the File Explorer utility on your Windows 11 PC. Resolving issues with this file manager is extremely important, as this tool is how you access all the files and folders on your machine. Good luck! Using File Explorer in Windows 11
is like opening a treasure chest of your digital world. First, click the File Explorer icon on your taskbar or press the Win + E keys on your keyboard to open it. You’ll see a sidebar on the left with quick access to your most-used folders like Downloads, Documents, and Pictures. Navigate through your files and folders by clicking on them. You can also
use the search bar on the top right to find a specific file. With this guide, managing your files on Windows 11 will be as simple as pie. File Explorer in Windows 11 is your go-to tool for accessing and managing files. Here’s a step-by-step tutorial to navigate it like a pro. Click the File Explorer icon on your taskbar. If the icon is missing, press Win + E
on your keyboard to open File Explorer instantly. Look at the left side of the window for the sidebar that lists your folders. The sidebar is handy for quick navigation. It lists folders like Quick Access, OneDrive, and This PC. Click any folder to open it. Click on ‘Quick Access’ in the sidebar to view frequently used files and folders. Quick Access compiles
the files and folders you often use, making it a fast way to find what you need without digging through layers of folders. Double-click any folder name to open and view its contents. This action allows you to drill down into folders to find the specific files you need. You can always go back by clicking the back arrow in the top left corner. Type the name
of the file you're looking for in the search bar at the top right. The search function is powerful, saving you time by filtering through your files to find exactly what you need in a jiffy. Once you complete these steps, you will have explored the basics of File Explorer in Windows 11. You now know how to open it, navigate quickly to frequently used
folders, and use the search function to find specific files. Customize the Quick Access toolbar for even faster navigation by pinning your most frequently used folders. Use the right-click menu to cut, copy, or paste files to organize them exactly how you want. Enable the preview pane from the View tab to see a preview of files before opening them. Use
the ‘Sort by’ and ‘Group by’ options to organize files by date, type, size, or other properties. Create new folders by right-clicking in the main window pane and selecting ‘New’ > ‘Folder’ to organize your files better. File Explorer is used for navigating, accessing, and managing files and folders on your computer. It’s your main hub for file management.
You can quickly open File Explorer by pressing Win + E on your keyboard or clicking the File Explorer icon on your taskbar. Yes, you can customize it by right-clicking on your favorite folders and selecting ‘Pin to Quick Access’. Use the search bar at the top right of the File Explorer window to type in the name of the file you're looking for. Yes, you
can enable the preview pane from the View tab to see a preview of files in certain formats before opening them. Open File Explorer using the taskbar icon or Win + E. Locate and use the sidebar for navigation. Click Quick Access for frequently used files. Double-click folders to view contents. Use search to find specific files. Navigating File Explorer in
Windows 11 doesn’t have to be a daunting task. With the steps and tips outlined in this guide, you can become the master of your digital files. Remember, the more you use these features, the more intuitive they will become. File Explorer is not just a tool; it’s like your personal assistant, helping you keep your digital life organized. Explore different
views, customize your Quick Access, and don’t shy away from using the search function - it’s there to make your life easier. If you've found this guide helpful, why not dive deeper into the world of Windows 11? There’s a lot more to learn, and every feature is designed to make your computing experience smoother. Are you ready to explore what’s
next? Matthew Burleigh has been writing tech tutorials since 2008. His writing has appeared on dozens of different websites and been read over 50 million times. After receiving his Bachelor’s and Master’s degrees in Computer Science he spent several years working in IT management for small businesses. However, he now works full time writing
content online and creating websites. His main writing topics include iPhones, Microsoft Office, Google Apps, Android, and Photoshop, but he has also written about many other tech topics as well. Read his full bio here.



